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FOUNDED MAY 1989


MEETINGS - SECOND 

  SATURDAY OF THE MONTH

SOME WEBSITES 

iOS app permissions: Do 
companies really need all of 
that access?  A white  paper 
provides suggestions for which 
permissions to limit. cutt.ly/
kW1aD8H.

5 Tips for Making the Most of 
Safari on macOS. Some very 
helpful tips from Mark Ellis. Try 
some of them. cutt.ly/wEQowlx.

10 Reasons to Upgrade to 
iPhone 13 (and 5 Reasons Not 
to Bother). Nice short article on 
reasons to and not to go to the 
iPhone 13,  cutt.ly/lEvFXuB.

When Should You Upgrade? 
Part 2: macOS 12 Monterey 
and tvOS 15 , Small Dog 
E l e c t ro n i c s re c o m m e n d s 
waiting to upgrade to Monterey 
for at least a few months. Going 
to be tough for some of us to 
wait that long. cutt.ly/GEvKOlo. 

ZOOM MEETING IN OCTOBER.  

GO TO ZOOM.US/DOWNLOAD TO DOWNLOAD THE APP.

Our main presenter will be Joe Kissell who will speak on Take Control 
of Monterey. macOS 12 Monterey ships this fall, and it’s full of 
interesting new features that can improve your productivity and 
privacy. It also has a few potentially unwelcome surprises, including 
some controversial changes to Safari. In this presentation, Joe Kissell 
takes you through the major changes in Monterey, from the flashy to 
the obscure. He covers the upgrade process, how to find your way 
around, and how to get started with features such as Focus, iCloud+, 
and Shortcuts. 

NL FOCUS - NEW APPLE PRODUCTS 
 TAKING CONTROL OF MONTEREY

Joe Kissell is the author of more than 60 books on Apple software 
and other technology-related topics. He is also (since 2017) the 
publisher of Take Control Books. Joe lives in San Diego with his wife, 

https://cutt.ly/kW1aD8H
https://cutt.ly/kW1aD8H
https://cutt.ly/wEQowlx
https://cutt.ly/lEvFXuB
https://cutt.ly/GEvKOlo
http://ZOOM.US/DOWNLOAD
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Membership Information

Membership dues are $30 for individuals and $40 for 
families. Memberships are based on your anniversary 

date, which is the month you joined. You will be e-
mailed reminders when membership fee is due. 

If you’re just visiting to check us out, or if you’ve 
been visiting for some time, but haven’t joined, 
consider these BENEFITS OF MEMBERSHIP:


• Monthly meetings, where you can learn, share, 
and meet everyone from working Mac 

professionals to new Mac users from all 
backgrounds.


• Monthly newsletter, which is full of interesting 
Mac news, tips, and information.


• Useful free items at the monthly Raffles. 

• Discounts. Vendors offer special prices to User 

Group members.

• Web Site with 2-3 years of MLMUG 

newsletters, meeting information, a member 
directory, directions to our meetings, and much 

more! Our web site is www.mlmug.org.

• MLMUG Mailing List, to post technical 

questions or comments to each other and the 
experts within the group. 


Are you ready to join? Please make a check 
payable to MLMUG and bring it to a monthly 

meeting or mail it to:

Treasurer, MLMUG


P.O. Box 1374

Southeastern, PA 19399


Multimedia SIG Co-Chair 
Nicholas Iacona


nick@nickiacona.com

Newer Users SIG Co-Chair & 

Webmaster 
Bob Barton


barton.bee.net@gmail.com

OS/iOS SIG Chair 

Adam Rice

adam@adamrice.org

Picnic Coordinator 

Tony DiPiano

tony@dipiano.net


Raffle Chair 
Susan Czarnecki


sparsefur@yahoo.com 
Social Secretary 
Gail Montgomery


gailemontgomery@comcast.net


President, Program Director & 
Vendor Liaison 

Maria O. Arguello

mariarguello@mac.com


Vice President & Multimedia SIG 
Co-Chair 

Larry Campbell

lcampbell9@me.com


Treasurer, Membership & 
Facilities Coordinator 

Elliott Cobin

eicobin@gmail.com


Secretary & Newsletter Editor 
Mark Bazrod


msb@lpilease.com 
Educational Liaison 

Linda McNeil

mcneil.linda@gmail.com


Member-at-Large, Newsletter 
Copy Editor & Apple User Group 

Ambassador 
Deane Lappin


deanezl@verizon.net


mailto:nick@nickiacona.com
mailto:barton@bee.net
mailto:adam@adamrice.org?subject=
http://www.apple.com
http://sparsefur@yahoo.com
mailto:gailemontgomery@comcast.net?subject=
http://www.mlmug.org
mailto:mariarguello@mac.com?subject=
mailto:lcampbell9@me.com
mailto:eicobin@gmail.com
mailto:msb@lpilease.com
mailto:mcneil.linda@gmail.com?subject=
mailto:deanezl@verizon.net?subject=
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Typical Meeting Agenda


9:00 - 9:05: 	 Call to order in main meeting 
room.


9:05 - 10:15: Q&A Panel - 3 or 4 expert 
members will answer your questions 
about anything relating to your Mac, 
iPad, iPhone, iWatch, and any 
attached peripherals.


	 Questions can relate to the most basic 
items, equipment issues, Apple’s 
o p e r a t i n g s y s t e m s , a n d a l l 
applications, including applications for 
photo, video, audio, and print media.


	 Answers are amazingly helpful and 
often in depth, exploring the subject 
beyond the question.


10:15 - 10:30: Welcome and other business.


10:30 - 11:50: Main Presentation (by a 
member or guest)


11:50 - Noon: Raffles and silent auctions.


Come join some fellow MLMUG members for 
lunch after the meeting at a nearby 
restaurant.


MLMUG Email list


The Main Line Macintosh Users 
Group has its own email list, 
hosted at Groups.io. Compose 
your letter and email it to 
MLMUG@groups.io  and your 
message will be sent to everyone 
on the mailing list. Contact Bob 
Barton (barton@bee.net) if you 
are a member and you are not on 
the list.

Please observe good email 
etiquette. If your message is 
humor or not Apple-related (off-
topic), please include "Humor" or 
"OT" in the subject line. The 
Groups.io Terms of Service are at 
groups.io/static/tos. Look for the 
section on "Conditions of Use"  

The MLMUG list may be used to 
post Apple-related items for sale, 
but any solicitation of members 
through the list is forbidden 
without the written consent of a 
MLMUG officer. Violation of the 
Groups.io terms of service or 
good email etiquette may result 
in removal from the list.

New Users SIG


You don’t have to wait a whole 
month to get answers to your basic 
Mac questions! Get together with 
other members on the fourth 
Saturday (i.e., two weeks after each 
regular meeting) for the Startup 
Folder Lite.


Many new users have said that they 
can learn much more from face-to-
face meetings than they do from 
manuals or other sources. That’s 
what this meeting is all about. Go 
to www.mlmug.org/nusfl.html for 
details.


http://groups.io
mailto:%20MLMUG@groups.io%20
mailto:barton@bee.net
http://groups.io/
https://groups.io/static/tos
http://groups.io/
http://www.mlmug.org/nusfl.html
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Bookmarks  
Safely Get Rid of an Old 
Computer 

By Mark Bazrod 
When are you getting rid of an old computer? Tomorrow? In five 
years? Never? Nonetheless, someone eventually will have to get 
rid of your old computer.

There's a ton of personal information on it. For example, tax 
returns, passwords, bank account numbers, investment 
information, names and phone numbers, and medical 
information.

You don't want this information falling into the wrong hands!

You have several choices: 
1.  Destroy the hard drive with a hammer or drill holes in it.


Getting the hard drive out may not be the easiest thing to do 
and smashing it with a hammer could be dangerous as 
fragments can fly around.


2.  Dump it in the trash somewhere. But someone may recover it 
and get your data.

3.  Give it to a recycling center. But you're still not sure where it's 
going and who’s seeing it.

4.  The best and safest choice.is to erase the information from 
the computer.

Erase your personal information 
1. Back up or transfer your important files. 

The least time-consuming and easiest way to do this is to buy 
and use an external hard drive, such as the Western Digital 1TB 
Passport ($60) or 2TB ($70).

Use a cloud service such as Google Drive, Apple iCloud, or 
Microsoft OneDrive. Google Drive gives you 15GB of free storage 
and 200GB for $3 a month/$30 per year. OneDrive gives you 
5GB free and 100GB for $2 a month. Apple iCloud gives you only 
5GB free and 50GB for $1 per month. 

2. Move files to new mac 
For a new Mac, Use Migration Assistant to copy all of your 
documents, apps, user accounts, and settings to a new Mac 
from your old computer. You don't have to copy them.

On your new Mac, open Migration Assistant in the Utilities folder 
of your Applications folder. Click Continue. Select the option to 
transfer from a Mac, Time Machine backup, Startup disk, or 
Windows PC. Click Continue.

On your old Mac, open Migration Assistant, then click Continue. 
Select the option to transfer to another Mac. Click Continue.

For additional easy steps, go to https://support.apple.com/en-
us/HT204350. But first read https://support.apple.com/en-us/
HT201065.

3. “Wipe” your hard drive  
Simply deleting files won’t cut it. The old file data is still there 
until it is overwritten; a bad guy can use a data recovery program 
to retrieve it.

A. Delete and overwrite sensitive files. If you have tax 

documents and other sensitive files, make sure you delete 
these files with specialized software designed to meet 
government standards for secure deletion. 


B. Deauthorize your computer. Some programs, such as 
iTunes and Microsoft Office 365, only allow you to install 
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software on a limited number of computers or allow a limited 
number of computers to access your files. This step is 
normally only necessary if you have more than 5 devices 
accessing the program.


C. Delete your browsing history. Most browsers save 
information about your browsing history and even store your 
user names and passwords for various sites. 


D. Delete your iCloud account unless you are getting 
another computer.  What you do is very varied, depending 
on your device. See apple.co/2NuGdva.


E. Erase and reinstall OS X. Go to Apple menu>Restart. Once 
the gray screen appears, hold down the Command and R 
keys. Select Disk Utility > Continue. Select your startup disk 
on the left, then tap the Erase tab. Choose Mac OS Extended 
(Journaled) from the Format menu, enter a name, then tap 
Erase. After the disk is erased, choose Disk Utility > Quit Disk 
Utility. Select Reinstall OS X>Continue & follow the 
instructions.


Dispose of your old computer 
1. Recycle your computer 
One of the best ways to recycle your computer is to contribute it 
to a charitable organization which will repair it and give it to a 
needy family. Google “charitable contribution of old computer 
[your county] PA” and you will find many organizations that can 
help you.

If you opt to recycle it, keep in mind that some recyclers will 
simply take your old machine and ship it over to developing 
nations where children are often used to scavenge piles of e-
waste looking for valuable components. 

Use a recycler that has been certified by Sustainable Electronics 
Recycling International or is part of the “e-Steward” network, 

meaning they don’t export to places like Pakistan or China. Many 
of them also will reuse and refurbish electronics. Staples is an e-
Steward Enterprise and will recycle laptops and other consumer 
electronics for free.

2. Trade-in your computer 
Tons of companies offer trade-in programs. Options include 
Apple (very good prices), BestBuy, Amazon,  and Staples. 
Compare the local store and the online services.

Conclusions 
Someone someday will need to erase your information from your 
computer.

The simplest procedure is to reset the computer to the factory 
settings.

I suggest you print this presentation, put it in a plastic bag, and 
attach it to the back or bottom of the computer. 
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Ian Sherr & Lori Grunin posted the following article to cnet.com 
on September 16, 2021. cutt.ly/NEutjyX.. © CBS Interactive Inc. 
Ian is an Editor at Large for CNET. Lori is Senior Editor / Reviews 
for CNET. 

iPhone 13 and All Of Apple's Most 
Exciting Announcements This Week 
Four new iPhones, the Apple Watch 7, new iPads and more were 
unveiled at Apple's event earlier this week. Here's everything in 
one place.


By Ian Sherr and Lori Grunin 

Apple's iPhone 13 event has been put to bed, and in it we got 
the expected iPhone 13 announcement, as well as a refreshed 
10.2-inch iPad, a big upgrade for the iPad Mini and a new Apple 
Watch Series 7. There were a few small announcements, too. We 
saw some upcoming show previews for Apple TV Plus, including 
the new season of The Morning Show and fresh titles like 
Foundation, and a comedy series, The Problem With Jon 
Stewart. (Stewart joked they may need to add a comma to that 
title.) 


We also got an announcement date for the release of the new 
mobile operating systems, iOS 15 and iPadOS 15: Sept. 20. Get 
ready to download and install them on your iPhone and iPad.


iPhone 13, Mini, Pro and Pro Max 
Apple showed off a complete new line of iPhones. They all get 
updated to a new A15 Bionic chip, a six-core CPU with two high-
performance cores, four high-efficiency cores and a quad-core 
GPU. 


The iPhone 13 Pro has wide-angle, ultrawide and telephoto 
cameras. 

All the back cameras have been significantly upgraded with 
wider apertures and new video features. The buzziest is 
Cinematic mode, which will allow phones to have professional-
level "rack focus" where you can slide between focus subjects 
gracefully in a video. You can also choose where to focus by 
tapping on the screen, or even holding down to lock focus on a 
subject.


• iPhone 13 brings a new design and stylish colors. Here's 
what to know


7

https://cutt.ly/NEutjyX
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• iPhone 13: Apple adds larger battery, more storage, 
cinematic video mode


• iPhone 13 Pro cameras: Why this pro photographer is 
excited


• iPhone 13 cameras stand out with macro photography, 
cinematic video


• iPhone 13 cameras stand out with macro photography, 
cinematic video


• iPhone 13 price and preorder: How and when to buy Apple's 
new phones


• iPhone 13 Pro and Pro Max: 120Hz display, 3 new cameras 
and all the goodies


• iPhone 13's starting storage is finally one we can 
recommend


• iPhone 13 release date: All models will be available on Sept. 
24


• Apple's iPhone 13 Mini promises to be small but mighty

• iPhone 13 Pro finally gets 1TB of storage for $1,499, 1TB 

Pro Max for $1,599

• Here's which iPhones are getting lower prices, and which 

Apple will stop selling

• iPhone 13 battery life: Your phone charge will last hours 

longer, Apple says

• Apple touts iPhone 13's privacy features, but doesn't 

address spyware worries

• iPhone 13 Pro gets Super Retina XDR display with 

ProMotion

• iPhone gets 3x optical zoom for the first time


• iPhone 13 will support 5G in 60 countries, work on over 200 
carriers this year


• Apple's iPad Mini sees a big upgrade: Support for USB-C 
charging


• Apple's A15 Bionic chip powers iPhone 13 with 15 billion 
transistors


The   iPhone 13 Pro camera now has a macro lens, able to shoot 
a subject from less than an inch away. Apple says it's also made 
improvements to the software that recognizes people's skin 
tones, and you can now apply tone and warmth filters that the 
camera will remember.

Apple says that despite the faster chip, 5G, better cameras and 
other features, the iPhone 13 has longer battery life than its 
predecessor. One way it does this is by shifting to LTE "when 5G 
speeds aren't needed."

Apple/Screenshot graphic omitted.

Apple is also getting its device to rely on the internet less. Many 
Siri requests for example will stay on the device, a first in the 10 
years since the voice assistant was first introduced.

The iPhone 13 Pro has a bigger battery, a new Super Retina XDR 
display with 1,000 nits of peak outdoor brightness, 25% higher 
than last year. And it can change frame rate on the fly, increasing 
frame rate to 120Hz when you need to match games and some 
video, but ramping it down to 10Hz when you don't. 

Prices remain the same as the last generation. The iPhone 13 
starts at $799 (£779, AU$1,349). The iPhone 13 Mini starts with 
double the capacity, 128GB, at $699 (£679, AU$1,199). You can 
also get a 512GB version now, which used to only be available 
on the Pro models. The iPhone 13 Pro will keep its $999 (£949, 
AU$1,699) starting price and the iPhone 13 Pro Max will start at 
$1,099 (£1,049, AU$1,849). Preorders open this Friday, Sept. 17, 
and the phone will appear in stores on Sept. 24.
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Apple Watch Series 7 
The new watch has a larger display, with 20% more screen area 
than the Series 6 and 50% more than Series 3. But the 
dimensions of the watch have barely changed, Apple says. And it 
has "softer, more rounded corners" with a "wraparound" feel on 
the sides.

Apple says it redesigned buttons in the software to make them 
easier to tap as well, and it can fit 50% more text on screen than 
last year's watch.


• Apple WatchOS 8 is best for bikers, can detect falls

• Apple Watch 7's fall release may be affected by component 

shortages

• Apple Fitness Plus now lets you work out with up to 32 

friends

• Apple Watch Series 7 gets larger display


The newest Apple Watches now have a "crack-resistant front 
crystal," with a "more robust geometry" and IP6X certification for 
additional dust resistance over the earlier model.

It has a bunch of new colors, bands and even a new charger 
that's faster. Like the iPad, Apple says it's 100% recycled 
aluminum.


The Apple Watch Series 7 will be $399, with international prices 
yet to be announced. It's not coming until later this fall, though. 
Apple will also keep selling the Apple Watch Series 3 for $199 
and last year's Apple Watch SE for $279. 

Since launching last year, Apple's focused its $10 per month 
Fitness Plus service on getting you to sweat. But this year, it's 
adding a meditation option, which will include all sorts of 
different calmness, kindness and gratitude meditations. Just like 
Apple's other classes, it'll be updated weekly on your phone and 
watch.

Apple's always had hidden features to compete with friends in its 
motion and activity app, and now the company's adding group 
workouts too. In this case, you can start a workout with (or 
against) your friends from an iMessage chat conversation. Apple 
says up to 32 people can participate and you'll even know when 
friends are ahead of you in a bike class, for example.


iPad and iPad Mini 
The new 10.2-inch iPad incorporates the A13 Bionic chip, Apple 
says, which is 20% faster than the A12 "in every aspect of the 
chip from the CPU and GPU to the neural engine." (The iPhone 
13 has the new A15 Bionic chip.) It has a larger display, with 20% 
more screen area than the Series 6 and 50% more than Series 3. 
The dimensions of the watch have barely changed, Apple says. 
And it has "softer, more rounded corners" with a "wraparound" 
feel on the sides. 

But the Mini is the bigger upgrade. 


• Apple 10.2-inch iPad updated with A13 chip, 64GB 
storage, 12-megapixel front camera, starts at $329

• Apple's new, redesigned iPad Mini will have a 5G option 
starting at $649

• Apple unveils redesigned iPad Mini with 8.3-inch display 
and 5G connectivity
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It ditches the home button, and has thinner screen bezels to fit 
the larger 8.3-inch True Tone screen, which has an antireflective 
coating and a brightness of 500 nits. It also comes in an array of 
colors, including purple, pink, "starlight" (a light gray) and space 
gray.

It also has Touch ID built into the power button, just like last 
year's iPad Air.

Apple says that the iPad Mini upgrade means that all the 
company's iPads are now made from 100% recycled aluminum, 
as well as 100% recycled tin (for the solder). Apple says it uses 
100% recycled rare earth elements in the enclosure magnets 
(though not everywhere).

Apple's iPads have always been portrait-oriented devices. The 
front-facing camera's always been at the top of the device when 
held vertically, and its speakers have always been at the bottom. 
With the iPad Mini, Apple's moved the selfie camera to the top of 
the landscape orientation, and added stereo speakers meant to 
be heard in landscape as well. 

The new iPad Mini's colors. 
Last year, Apple introduced faster 5G wireless to the iPhone. This 
year, it's adding the technology to all its iPads, starting with the 

iPad Pro in April. Now, the iPad Mini gets 5G, which Apple said 
can pull down 3.5 gigabits of data per second. It also gets a 
USB-C port like its iPad Pro big brothers.

The iPad starts at $329 (£319, AU$499) and the iPad Mini starts 
at $499 (£479, AU$749).

Our liveblog archive follows. [Omitted]

And that's it
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SPEAKER ROSTER FOR

MLMUG'S 2021 MEETINGS


January 11`	 	 Dan Wissink - Dan’s Tutorials

February 9 Terry Wilson - Cut the Cord to
       Microsoft Office - Pages/Numbers
March 13 Michael Blank - Pixlr.com Graphics
April 10 Gary Rosenzweig - Fun With Text 

       In Pages
May 8 Dave Hamilton - Plex: Stream… 
June  Rob Golding - Backup Strategies
July	 	 	 Recess - Summer

August	 	 Recess - Summer

September 11 	 Aric Pedersen —Virtualizing macOS

October 9 	 	 Joe Kissell - Take Control of Monterey

November 13 Bob "Dr. Mac" LeVitus - TBD
December 11 	 Keith Johnson - FileMaker Pro 
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Eli Blumenthal posted the following article to cnet.com on J 
September 16, 2021. cutt.ly/rEtYPhN. © CBS Interactive Inc. He 
is a senior editor at CNET. He previously worked as a technology 
reporter at USA Today. 

Apple's Best iPhone 13 Features Are the 
Trade-in Offers, Not the Specs 
You could save a lot of money on an iPhone 13 with the right 
offer. 

Tim Cook unveiled the iPhone 13 at Tuesday's Apple event. 

By Eli Blumenthal 
This story is part of Apple Event, our full coverage of the latest 
news from Apple.

Apple's new  iPhone 13 and 13 Pro phones have lots of new 
features that are welcome upgrades over earlier iPhone models. 
Battery life is longer, there are nifty camera tricks, better displays, 
a slimmer notch and even some new color options. While this 
stealth "S year" upgrade isn't as significant as last year's 
redesign and inclusion of 5G, there is enough here that Apple will 
still likely move many, many millions of iPhones. 

Especially when you consider the carrier pricing here in the US. 


All three of the major wireless providers have introduced new 
iPhone offers to get people to upgrade their older devices to 
these 5G-capable iPhones. As has been the trend in recent 
years, these offers are available to both new and existing 
customers, offering significant discounts on all versions of the 
new iPhone 13 if you're willing to upgrade and commit to staying 
with a carrier for several years. 

The deals represent a push by the carriers to not just pick off 
new customers from each other, but to lock in their current 
customers with longer deals. The floodgates of deals opened last 
year, when the companies were eager to get people on their 5G 
networks, and they're continuing with the iPhone 13 launch. 
While it's a good time for those looking for a good deal, 
consumers should be aware that terms can stretch out as far as 
three years. 

Apple went so far as to acknowledge carrier discounts during its 
presentation on Tuesday with Kaiann Drance, Apple's vice 
president of iPhone product marketing, noting that there are 
"some fantastic offers from Apple and our partners" when 
mentioning the pricing of the iPhone 13. 

AT&T is offering up to $1,000 off the iPhone 13 Pro or Pro Max 
and up to $700 off the iPhone 13 and Mini, essentially making the 
iPhone 13 Pro or 13 Mini free. Verizon is offering up to $800 off 
any iPhone 13, covering the base costs for the 13 and the Mini. 

Read more: iPhone 13 vs. 13 Mini vs. 13 Pro vs. 13 Pro Max: All 
the biggest differences

Both carriers will need you to trade in a fairly recent phone and 
be on an unlimited plan (in Verizon's case, one of its current 
higher-tier unlimited offerings such as Do More, Get More and 
Play More or older Above Unlimited and Beyond Unlimited plans) 
to get full credit. AT&T also requires that your device be in good 
working condition while Verizon will take any phone -- even those 
with broken screens -- so long as its battery is undamaged. 
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T-Mobile's most aggressive offer comes from Apple directly. If 
you're buying from Apple and trading in an iPhone X or newer, 
the company will give you a credit of at least $200 from Apple 
toward the price of the phone and a minimum of $200 back from 
T-Mobile. Those numbers can quickly jump if you're trading in a 
new device and have the carrier's top plan, called Magenta Max. 

If you have Magenta Max and are trading in an iPhone 12 Pro 
Max you'll get $790 back from Apple, with T-Mobile kicking in an 
additional $500 through bill credits for a total savings of $1,290. 

More directly, T-Mobile is offering up to $500 off the price of any 
iPhone 13 series phone, so long as you finance on an installment 
plan and trade in an eligible device. This offer doesn't require a 
Magenta Max plan and will work with any of the company's other 
offerings. 


Playing for keeps 
The catch in all cases is that you need to be willing to stay with 
whichever carrier you choose, because the discounts come back 
to you as monthly bill credits. 

AT&T's deal requires financing the phone over 36 months. 
Verizon requires you to finance over the course of either 24 or 30 
months, while T-Mobile's Apple deal will give the carrier's portion 

of promotion through bill credits over 24 months (the phone 
trade-in to Apple can be used as an instant credit). T-Mobile's 
direct $500-off promotion requires buying an iPhone 13 on a 30-
month installment plan. 

In any of these cases, if you cancel service or leave early, you 
risk losing the remaining bill credits and being charged the 
outstanding balance owed on the phones. 

"Now that US carriers are rolling out 5G networks in earnest, they 
are trying to shore up their subscriber base to keep the 
competition at bay," says Avi Greengart, an industry analyst at 
Techsponential. "They are all ensuring that these deals pay off by 
tying them to their most expensive service plans, requiring trade-
ins and extending the subsidies over two or even three years."

Read more: iPhone 13 price and preorder: How and when to buy 
Apple's new phones

On top of the upgrade offers today, some carriers like T-Mobile 
have added new incentives to keep people tied to their networks 
for even longer periods of time, well past the iPhone 12 or 13. 


In a policy called the "Forever Upgrade," starting on Friday T-
Mobile is guaranteeing a trade-in value of up to $800 for those 
on its network who buy a new iPhone 12 or 13 and have its 
highest-tier Magenta Max plan (other older, high-end T-Mobile or 
Sprint plans are also eligible). 


As with all the other deals, there is a catch. In addition to the plan 
requirements, that $800 trade-in value won't become reality 
unless you wait two years and keep the device in good working 
condition. At that point you can once again trade in the iPhone 
you are getting now and put that money toward a new device, 
keeping the cycle going. 


Carrier deals like the ones offered by T-Mobile "are designed to 
drive more consumer loyalty" and keep people from leaving, said 
Anshel Sag, a senior analyst at Moor Insights and Strategy. And 
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because so many of these deals require a higher-tier unlimited 
plan, Sag notes that the carriers are "happier to keep these 
customers rather than letting them go to someone else who has 
more aggressive iPhone offers."


See also


• Should you upgrade to iPhone 13? We compare to iPhone 
12 through iPhone 7 to find out


• Everything announced at Apple's iPhone 13 event


• Apple unveils the iPhone 13 Pro and Pro Max with 
ProMotion and faster performance


• iPhone 13: Apple announces its latest phone during an epic 
virtual event


• Apple Watch Series 7: A whole new design


• Apple iPad gets refreshed for 2021 with A13 chip, 12-
megapixel camera, 64GB storage, $399


• Apple unveils redesigned iPad Mini starting at $499





Josh Centers posted the following article to tidbits.com on 
September 20, 2021. cutt.ly/LEvR5gs. © TidBITS Publishing Inc. 
He is the managing editor of TidBITS, as well as a contributor to 
Macworld and Sweethome. 

iOS 15, iPadOS 15, watchOS 8, and tvOS 
15 Now Available 
By Josh Centers 
Today is the day. Apple has released iOS 15, iPadOS 15, 
watchOS 8, and tvOS 15. Apple’s servers will probably be 
slammed with all the traffic, and there may be first-day bugs. If 
you’re the sort who installs new operating systems right away, go 
ahead—the betas have been stable—but we recommend that 
most people wait at least a week or two. If you’re particularly 
upgrade-shy, Apple is finally allowing users to stick with iOS 14 
and iPadOS 14, which will continue to receive security updates. 
Nevertheless, we always recommend upgrading eventually, when 
it’s convenient and sensible for you (see “Why You Should 
Upgrade (On Your Own Terms),” 4 September 2015)


iOS 15 and iPadOS 15 
iOS 15 and iPadOS 15 offer a slew of new features. Here are the 
highlights:

• Massively improved FaceTime, with many of the features 

you’ve become accustomed to in videoconferencing apps 
like Zoom


• Shared With You collections in Messages, Photos, and 
other apps for bringing together content and links that 
people share with you


• Focus, which is like a more customizable Do Not Disturb. 
You can create multiple Focuses that allow notifications 
only from specified apps or contacts.
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• Time-sensitive notifications (like reminders that go off at a 
particular time) that can optionally break through a Focus. 
Plus, notifications are now slimmer and have more 
prominent icons.


• Notification summaries, which bundle notifications that 
aren’t time-critical and display them to you at set times 
during the day


• Significant Safari changes, including the address bar 
moving to the bottom of the screen in iOS (so it’s easier to 
reach), Tab Groups, which let you organize tabs by topic or 
project, and voice search


• Live Text in Photos, which lets you do things like copy text 
from photos or search for text in photos


• New iCloud+ features, like Private Relay and Hide My Email

• Redesigned Memories in Photos

• A redesigned Weather app in iOS 15 that includes 

notifications for rain and other weather events. (Sadly and 
increasingly weirdly, Apple still has no Weather app for 
iPadOS. Maybe next year.)


• More discoverable multitasking capabilities on the iPad, 
thanks to a Multitasking menu at the top center of every 
window and a shelf at the bottom that shows open windows 
within an app


• App Library and Home screen widgets on the iPad. These 
features work just like they do in iOS 14, albeit with larger 
widgets on the iPad.


• Quick Note, which lets you create a note with a swipe up 
from the corner of the screen on an iPad


iOS 15 and iPadOS 15 support the same devices as iOS 14 and 
iPadOS 14, meaning everything back to 2015’s iPhone 6s and 
2014’s iPad Air 2. Kudos to Apple for continuing to keep these 

older devices on the train. However, some features require newer 
devices, specifically the A12 Bionic processor or later. See “The 
Real System Requirements for Apple’s 2021 Operating Systems” 
(11 June 2021) for details on those.

My new book, Take Control of iOS 15 and iPadOS 15, covers 
these topics in detail, and we have articles planned to go in-
depth on what we consider to be the most interesting features of 
iOS 15 and iPadOS 15 in the coming weeks. I’ve been running 
these betas all summer, and they’ve been very stable for me. Nor 
have I heard about major problems from other beta testers. 
However, there could be subtle but problematic bugs that won’t 
become obvious until these operating systems are running on 
millions of devices.

Apple decided to delay some promised features for later 
releases:

• SharePlay, which let you watch movies or listen to music 

with others over FaceTime

• Screen sharing over FaceTime

• Legacy Contacts, which let you designate someone to 

inherit your iCloud data upon your death. It was available in 
earlier betas (I even have my QR code printed out) but won’t 
return until later.


• App Privacy Report. Apple apparently planned to delay this 
from the start. If it’s like App Tracking Transparency from 
iOS 15, I would expect it to arrive around iOS 15.5 or so.


You can install iOS 15 and iPadOS 15 in Settings > General > 
Software Update—you’ll likely need to tap Upgrade to iOS 15 at 
the bottom of the screen. On an iPhone 11 Pro, iOS 15 clocks in 
at 3.24 GB. On an old iPad Air 2, iPadOS 15 is only 2.43 GB, 
perhaps because it doesn’t include code for unsupported 
features.
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watchOS 8 
The watchOS 8 update isn’t quite as exciting as iOS 15, but it still 
includes many nice improvements:

• Better photo support, including Portrait mode watch faces, 

better Memories support, and easier sharing of photos

• A redesigned Home app that better supports security 

cameras and scenes and displays status symbols for 
devices


• The option to edit text with the Digital Crown

• The capability to look up and share animated GIFs in 

messages

• A Find My app for locating lost devices from your wrist

• A redesigned Music app that makes sharing easier


• A new Mindfulness app that replaces the Breathe app

• The capability to track your sleeping respiratory rate


To install the update, which was 1.2 GB for an Apple Watch 
Series 4, open the Watch app on your iPhone and go to My 
Watch > General > Software Update. Remember that the 
download will take a while, after which the iPhone has to transfer 
the update to your Apple Watch through Bluetooth, which can 
take a couple of hours. Then, to install the update, the Apple 
Watch must have at least 50% charge and be connected to a 
charger. We recommend performing the upgrade at night.


tvOS 15 
As usual, tvOS 15 didn’t get as much attention as the higher-
profile operating systems. Apple delayed its main feature, 
SharePlay, for a future release. However, there are still a few 
welcome changes in tvOS 15:
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• A For All of You section in the TV app, which tries to 
suggest content your entire household will enjoy, based on 
their preferences


• Shared with You, which displays shows and movies shared 
with you from Messages in iOS 15


• Spatial audio support for AirPods Pro and AirPods Max, 
plus smart audio routing for AirPods


• The capability to view multiple HomeKit cameras at once

• Stereo sound when you pair two HomePod mini speakers to 

an Apple TV 4K

tvOS 15 supports the Apple TV HD and Apple TV 4K.

To install the update, go to Settings > System > Software 
Update, or just let it install on its own at some point in the future.


HomePod Software Version 15 
Finally, Apple quietly released HomePod Software Version 15. In 
what seems like a slight change in iOS 15’s version of the Home 
app, an icon for Update Downloading appears at the top of the 
screen. Tapping it reveals more information about the update, 
revealing what’s new:

• As noted above, you can now use the HomePod mini (by 

itself or in a stereo pair) with an Apple TV 4K.

• Media playback controls now appear on your iPhone’s Lock 

screen when a HomePod mini is playing nearby.

• You can use Siri on a HomePod to turn on and control an 

Apple TV.

• Siri automatically adjusts its volume based on the room 

environment and how you’ve set the loudness.

• You can ask Siri to control HomeKit devices at a specific 

time—”Hey Siri, turn off the kitchen lights in 5 minutes.”


• If you have HomeKit accessories with Siri support, you can 
use them to control the HomePod.


• If you have a security camera that supports HomeKit Secure 
Video, your HomePod can theoretically now alert you when 
a package arrives at your door.
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Roman Loyola posted the following article to macworld.com on 
September 21, 2021. cutt.ly/SEvE0CJ. © IDG Consumer & SMB. 
He is a Senior Editor at Macworld and has covered technology 
since the early 1990s. 

Safari 15 for macOS Now Available: New 
macOS Tabs Will Transform Your 
Workflow 
Get your websites in order. 

By Roman Loyola


Tabs are a major user interface element in Safari for macOS—we 
use them all the time, but they become unwieldly and hard to 
manage. Apple hopes to address those problems in Safari 15 
with a new tab implementation and features.

Safari 15 is officially available now and will be in the upcoming 
macOS Monterey. To download it in macOS Bug Sur, click on the 
Apple menu > About This Mac, and then in the Overview section, 
click the Software Update button. Once it’s installed, you can 
give the tabs features a try. Here’s how tabs work in Safari 15 
and how to make tab groups.


New tab UI 

Safari’s toolbar can take on the color used by a website. 
Apple changed the way tabs are displayed in Safari 15. 
Previously, the new tab you created appeared below the 
Address/Search box and the Favorites Bar. Now tabs occupy the 
space of the Address/Search box, which allows a bit more of a 
webpage to show on the screen. A nice design touch in Safari 15 
is that the toolbar can take on the color of a website. It’s a subtle 
way to let you know what site you are on, which can be helpful if 
you have several tabs open.

This new UI is on by default, but you do have the option to 
switch to a more familiar design, where the Address/Search box 
stays put in the middle and the tabs appear below it. Go to 
View > Show Separate Tab Bar and Safari will revert back.
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You have the option to change how tabs are displayed in Safari 
15. 

Tab groups: The basics 
Web research can involve visiting several websites, and 
sometimes you have a bunch of websites open in tabs, each one 
relevant to what you’re doing. In Safari 15, you can now save 
groups of those tabs together as a “tab group” and open that set 
of tabs whenever you want. For example, if you have a set of 
websites you like to visit for planning a vacation, you can save 
that set of sites as a tab group, and open that set when it’s time 
to plan your next trip.  

To create a tab group, set up Safari so the sites you want in the 
group are open in a tab. Click on the  File menu, and then 
select New Tab Group with x Tabs (the “x” will be the number of 
tabs currently open). 

Another way to create a tab group is to find the Show Sidebar 
icon on the upper right and click on the down arrow to the right. 

A pop-up menu will appear and you can select New Tab Group 
with x Tabs.


To add a tab to a tab group, just open a new tab and go to the 
site you want. To delete a tab  from a tab group, open the tab 
group, and then close the tab. All the changes are automatically 
saved to the group.

You can also create an empty tab group, which will have no tabs 
at the start. Then, any tabs you create are automatically saved in 
the group. You can create an empty tab group through  File 
> New Empty Tab Group, or by pressing Control+Command+N, 
or by clicking the down arrow icon to the right of the Show 
Sidebar icon and selecting New Empty Tab Group.


Tab groups: Organizing and syncing 
To open a tab group, click on the down arrow icon to the right of 
the Show Sidebar icon. In the menu that appears, your tab 
groups are listed in the middle section. Click on the group that 
you want to open it.
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You can also open a tab group through the Sidebar. Open the 
Sidebar by clicking the Show Sidebar in the upper left, or 
through File > Show Sidebar, or by pressing Shift+Command+L. 
In the Sidebar you’ll find a section called Tab Groups. To open a 
tab group, click on one and the tabs will open in the main 
window.


To see thumbnails of the tabs, click on the icon of four squares 
to the right of the tab group’s name. Or right-click the tab group 
and select Show Tab Overview.


You can view thumbnails of the tabs in a tab group. 

To rename a tab group, click on tab group to select it, then click 
on the name to trigger the ability to rename it. Or right-click the 
tab group and select Rename.


To delete a tab group, right-click it and select Delete. Or click on 
it to select it, and then click on the File menu and select Delete 
Tab Group.


If you right-click on a tab group, you have a couple more useful 
functions other than the ones previously mentioned.


• Copy Links: When you select this, A bulleted, hyperlinked list 
is created on your clipboard. When you paste it, the tab group 
name appears at the list’s title, and then each bulleted item is 
the hyperlinked title of each tab.


• At the bottom of right-click menu is a  list of the sites  in each 
tab. You can select one and it will load in the main window.


Tab groups sync across devices, so you can use them on your 
iPhone, iPad, or other Macs.


The Copy Links function creates a hyperlinked bulleted list of 
your tab group. Here is what the list looks like when pasted into 

Pages. Clicking on each listing opens that webpage in a browser. 

 

19



                 VOLUME 32, NUMBER 10                  MAIN LINE MACINTOSH USERS GROUP             OCTOBER 2021 

The Useful Tech posted the following article to medium.com on 
September 11, 2021. cutt.ly/KEil9QR. I have no other information. 
9 graphics have been omitted. Go to the original to view them. 

7 Crazy Features Coming to Apple 
Products in 2022 and Beyond 
By The Useful Tech 
These features are going to change everything drastically 

Source: Patently Apple 

Siri responding only to your voice 
It is a well-known fact that Apple is largely a privacy-focused 
company and is trying to integrate privacy and security features 
on all of its products wherever possible. One such upcoming and 
welcoming privacy-based feature is going to be added to Siri in 
the near future.

This feature will introduce a voice-recognition system to Siri that 
will differentiate your voice and a stranger’s voice and will only 
respond to queries and perform requested actions if it recognizes 
your voice.


Graphic omitted.

In a patent from Apple published by the US Patent & Trademark 
Office, it is revealed that this feature will first be added to AirPods 
and will later make its way into other Apple products like the 
iPhone, Mac, Homepod, etc.


Apple Pencil for iPhone, Mac, and Touchpad 
Graphic omitted.

In another patent filed by Apple, it is revealed that Apple is 
working on a dual touch sensor for iPhones, Macs, and 
touchpads. This dual-touch sensor can detect both passive 
conductive objects like our fingers and styluses, active styluses 
like the Apple Pencil.

Graphic omitted.

Since the dual touch sensor can support both passive and active 
touches simultaneously, this feature on iPhones or Macs might 
not function similar to the Apple Pencil on iPads and probably 
won’t be supporting palm rejection or other features. However, it 
would still be a great way to take handwritten notes and to jot 
down quick drawings on your iPhone or Mac.


iPhone with reverse wireless charging 
Reverse wireless charging is not a completely new feature to the 
smartphone world, and other manufacturers like Samsung and 
Huawei have already dabbed on this for a while now.

Graphic omitted.

Apple seems to be the latest company to join this bandwagon, 
and according to a patent filed by them recently, future iPhones 
would have a linear fluorinated polymer coating that offers 
fingerprint resistance and reverse wireless charging features.

Graphic omitted.
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Along with iPhones, future iPads are also expected to have a 
similar coating on their rear panels that will support reverse 
wireless charging. Once the reverse wireless charging feature has 
been made available on iPhones and iPads, it could probably 
support charging of other Apple devices like AirPods, Apple 
Watch, and even other iPhones by placing them on the back of 
your iPhone or iPad.


MacBook With a Virtual Keyboard and iPhone 
Charging Panel 
Graphics omitted.

This is probably one of the most exciting features on this list, and 
based on a patent filed by Apple, it is expected that future 
MacBooks will have a virtual interface that will be replacing the 
physical keyboard area, and this virtual interface could potentially 
be configured to have keyboard buttons, gaming interface icons 
or glyphs, app-based controls and even a virtual touchpad.


Source: Patently Apple 
The virtual interface could also be configured to accept gesture-
based inputs like pinch to zoom, slide to scroll, and more. 

Another exciting feature revealed in the patent is that the new 
design for the MacBooks might also include a wireless charger at 
the bottom left corner of the MacBook that you could use for 
charging your iPhones or even your Apple Watch and AirPods.


AirPods with temperature sensing 
With Apple adding more and more health-related features to all of 
its products like iPhone, Apple Watch, and Macs, it is no surprise 
that they are looking into adding similar functionality to their 
AirPods as well.

In a recent patent filed by Apple, it is reported that Apple would 
be adding temperature sensor packages to future AirPods that 
would help measure the users' skin temperature. This sensor will 
help better monitor all aspects of a user’s health, and by 
measuring your skin temperature, it would be easier to predict 
blood flow and determine if you have any fever.

Graphic omitted.

This feature might also make its way into the future Apple Watch 
versions as Apple has plans to integrate the temperature sensor 
packages to the fabric of wearable devices that would be directly 
in contact with your skin.


Magic keyboard with a wireless charging pad 
The Magic keyboard for iPad is one of the most successful 
accessories that Apple recently introduced. This new feature that 
Apple might add to the upcoming keyboard versions might 
increase its sales significantly. According to a recent patent 
application, Apple is working on a future version of the Magic 
Keyboard with a wireless charging feature that you could use for 
charging your iPhone, Apple Watch, and even your AirPods.

Graphic omitted.

This feature might work similar to MagSafe chargers, as the 
patent also details that the wireless charger coil will be housing 
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magnets to hold the charging device in place perfectly. The new 
design might also include a battery that will receive and store 
wireless power, so you might not even have to connect your 
Magic Keyboard to a power source to use the wireless charging 
feature.


MacBook with an Integrated Bio-Sensor 
I am currently using an M1 Mac Mini as my main computer, and 
once Apple has officially announced this feature, I might seriously 
consider purchasing a MacBook as well. A recent patent filed by 
Apple reveals that future MacBooks would have an integrated 
bio-sensor in the palm rest area, and it would be used for 
measuring various health metrics of the users.

This feature would be great for all non-Apple Watch users and 
even if you own an Apple Watch, as you probably won’t be 
wearing it all the time. With an integrated bio-sensor built into 
your MacBook and positioned right where you place your hand 
the most, it would be highly beneficial to know how your health 
conditions are at all times.

Graphic omitted.

The bio-sensor integrated into your MacBook is expected to 
determine and measure various health aspects of a user like 
heart rate, blood pressure, water content, blood oxygenation 
level, respiration rate, and more. If you spend long hours on your 
MacBook, then you could really benefit from this feature as it 
would track your health data across several days and even 
determine trends that could be used to understand your health 
condition better. 

Farad Manjoo posted following article to nytimes.com on 
September 16, 2021. cutt.ly/aEpjpER. © The New York Times 
Company. He is the "State of the Art" columnist for The Times 
and was a technology columnist for the Wall Street Journal. 

Apple and Facebook Are Coming for Your 
Face Next
By Farhad Manjoo 
It is difficult to avoid sounding 
vulgar, somehow, when discussing 
the future of facial computing. There 
is something inescapably crude, 
isn’t there, about the prospect of 
everyone walking around with 
computers on our faces?

And yet I suspect the world may 
adopt face computers anyway, and 
not long from now, perhaps even 
within the coming decade. People in 
tech have long been wondering what might succeed 
smartphones as the next dominant computing platform. For a 
long time I’ve thought that nothing would — that phones would 
remain our primary computers for the foreseeable future. In the 
past few months, though, I’ve begun to face the fact that our 
faces are … in trouble.

The face computer is coming — brace yourself for an onslaught 
of “smart” glasses, virtual-reality headsets and other devices that 
connect your eyes to the digital world.

So far there have been only a few such machines, most famously 
Google’s failed digital specs, Google Glass. Facebook and Ray-
Ban recently unveiled camera-enabled sunglasses; Snap, which 
makes Snapchat, also has such a device. The sunglasses let you 
photograph life in the moment, from your eyes’ point of view; 
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when you’re building sand castles at the beach with your kids, 
you can tap your specs to capture the memory while you’re living 
it rather than reaching for your phone with sandy fingers.

Facebook and Microsoft are making virtual-reality headsets, too. 
These function as powerful personal computers mounted to your 
eyes, creating an enveloping digital experience — video games 
and movies surround you, the real world replaced by the 
machine.

Though none of these devices has been a huge success, the 
tech that powers face-mounted computers is getting quite good 
quite fast. It is probably only a few years until a face computer 
hits big — perhaps when Apple releases the one it has been 
reported to be working on.

There are enormous social, cultural and legal reasons to worry 
about face computers becoming ubiquitous. Such devices could 
turn your eyes into constantly recording dashcams, superimpose 
Instagrammy toxicity over your real-life conversations and add a 
layer of reality-bending computer graphics to everything you see. 
It doesn’t help that they are being developed by some of the 
most intrusive, least trustworthy corporations in the world.

But if creepiness posed a fatal impediment to success in tech the 
industry, we wouldn’t have smartphones or Facebook. Here’s the 
thing about face computers: With the right design, when their 
components inevitably become small and powerful enough, 
these machines could make computing much more visceral and 
accessible, which most likely means more irresistible, too. I worry 
about the sudden inevitability of face computers — that, as 
happened with smartphones, they could become ubiquitous 
before society begins to appreciate the way they might be 
altering everything.

I say this having used a lot of pretty bad face computers over the 
past few years. Even the worst of them suggested a compelling 
goal. Face computers promise to improve the two things we 

most often do on our phones: watch stuff and take pictures of 
stuff. A computer you can always see paired with a camera 
always watching whatever you are — isn’t it obvious how such a 
device might fit in during the age of YouTube and TikTok?

Face computers also mitigate two of the touch-screen phone’s 
biggest shortcomings — the touch and the screen. My phone 
claims to help me, and yet it demands constant attention from 
my fingers and my eyes. In this economy?

This is the best pitch for the face computer: It lets you get digital 
information more flexibly than you can on any other device.

On the one hand, these machines can conjure experiences that 
are much more intense than on any other device. With a face 
computer, you’re not just watching videos online — you’re 
inhabiting them in a way that feels embodied.

Recently I’ve been hooked on Facebook’s Oculus Quest 2, the 
light, portable virtual-reality headset released late last year. What 
I like about it is its depth of experience: I’m not usually a gamer, 
but the Quest 2 has a large library of immersive titles that I found 
entrancing, among them a rock-climbing game whose perilous 
realism made my hands clammy.

Virtual reality will conquer gaming because it is unmatched at 
affecting your entire physical experience — when you ride a 
virtual-reality roller coster, your stomach drops just like on the 
real thing. Even ordinary videos gain from the V.R. experience — I 
found that scrolling through high-resolution nature videos on 
YouTube’s virtual-reality app is a wonderful way to remember 
what it was like when we were allowed to leave our houses.

Mainly we’ll use these things for fun. But there’s a chance V.R. 
catches on for other uses, too. Nutty as it sounds, I have been 
meditating in V.R. — picking some peaceful virtual spot and 
sitting there silently, just “feeling” the world around me. Yes, it’s 
super dorky; it’s also terrifically relaxing.
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Computers conquered our lives during the pandemic, but it’s the 
rare Zoom meeting that doesn’t feel lo-fi, awkward and distant. 
Talking to people over V.R. is natural by comparison; because the 
headset lets the digital world fully engulf your senses, it has the 
ironic effect of liberating you from the ever-present sensation that 
all of your interactions are being mediated by machines.


I still don’t think V.R. is for everyone — the experience is so 
immersive that it often feels impractical. V.R. shuts out the offline 
world entirely, demanding all your attention. Who has time to 
drop everything to climb a virtual mountain?


And so tech companies have been experimenting with less 
immersive machines for your face, what some call augmented 
reality. This is the world that Google imagined when it started 
selling its Glass spectacles in 2014.


As a matter of technology, Glass was a marvel — Google had 
stuffed a display, speakers and a camera into a machine built 
only slightly obtrusively into eyeglass frames. One knock on 
Glass was that it didn’t do a whole lot to justify its price; it could 
snap short videos and display digital tidbits, like the weather, in 
the corner of your visual frame, for $1,500.


Yet function is rarely an obvious impediment in wearable tech. 
Wristwatches only tell time, and sunglasses only tell the world 
you’re awesome. In some ways not doing too much was the 
point of Glass. The specs promised to offer you digital 
information more discreetly than your phone could. It imagined a 
visual field one day enriched by information — the latest 
headlines and your incoming texts superimposed over your walk 
home, a cable-news chyron on the lower third of your life: 
SPOUSE SAYS MILK GONE. BLAME BIDEN?


The big problem with Google Glass was not technical but social. 
Despite the company’s best efforts to make Glass cool, the 
people who first got the device tended to be of a certain type — 

overconfident, entitled, rich tech guys. Soon they earned a 
derisive nickname — “glassholes” — and at that point the device 
was done for.


A lot has changed since Glass’s release. Cameras and mobile 
processors are smaller and more powerful; now Glass-like tech 
can be built into spectacles without much sacrifice in style. There 
is also far less social opprobrium attached to wearable tech; 
earbuds and smart watches are not just for rich nerds. And for a 
lot of people, especially young people, there is little separation 
anymore between the online world and the offline world — 
suggesting potentially huge demand for glasses that fix the 
internet to your eyeballs.


I also wonder if the pandemic might have eased people’s 
inhibitions about wearing something on their faces. Yes, a lot of 
people have recoiled at face masks, but a lot more are now quite 
comfortable both wearing them and seeing others wear them.


To me the stage feels set in a way that recalls the period before 
the iPhone’s release in 2007. Technology and consumer 
preferences are aligning. We’re on the cusp of something big. I 
only hope that, unlike with smartphones, this time we go slow. 
Smartphones became an inescapable fact of modern life long 
before we understood all the ways they would alter society, for 
better and for worse. Now, as the machines march for our faces, 
let’s at least keep our eyes wide open. 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Coral Murphy Marcos & Kellen Browning posted following article 
to nytimes.com on September 3, 2021. cutt.ly/TWY4I2I. © The 
New York Times Company. Coral is a business reporter for the 
Times. Kellen is a technology reporter in the Bay Area. 

Apple Delays The Rollout Of Child-
Safety Features Over Privacy Concerns. 

One Apple feature would allow parents to activate an alert when 
their children sent or received nude photographs in text 
messages.Apple 

By Coral Murphy Marcos & Kellen Browning 
Apple said on Friday that it would delay its rollout of child safety 
measures, which would have allowed it to scan users’ iPhones to 
detect images of child sexual abuse, after criticism from privacy 
groups.

The company announced in early August that iPhones would 
begin using complex technology to spot images of child sexual 
abuse, commonly known as child pornography, that users 
uploaded to its iCloud storage service. Apple also said it would 

let parents turn on a feature that could flag them when their 
children sent or received nude photos in text messages.

The measures faced strong resistance from computer scientists, 
privacy groups and civil-liberty lawyers because the features 
represented the first technology that would allow a company to 
look at a person’s private data and report it to law enforcement 
authorities.

“Based on feedback from customers, advocacy groups, 
researchers and others, we have decided to take additional time 
over the coming months to collect input and make improvements 
before releasing these critically important child safety features,” 
Apple said in statement posted to its website.

The feature would have allowed Apple’s virtual assistant, Siri, to 
direct people who asked about child sexual abuse to appropriate 
resources, as well as enable parents to turn on technology that 
scans images in their children’s text messages for nudity.

The tool that generated the most backlash, however, was a 
software program that would have scanned users’ iPhone photos 
and compared them with a database of known child sexual 
abuse images.

The tech giant announced the changes after reports in The New 
York Times showed the proliferation of child sexual abuse images 
online.

Matthew Green, a computer science professor at Johns Hopkins 
University, said that once the ability to sift through users’ private 
photos was out there, it would have been ripe for misuse. 
Governments, for example, could potentially lean on Apple’s 
technology to help track down dissidents.

Apple argued that it was “going to resist pressure from all 
governments in the world, including China,” Mr. Green said. 
“That didn’t seem like a very safe system.”
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Apple did not appear to anticipate such a backlash. When the 
company announced the changes, it sent reporters technical 
explainers and statements from child-safety groups and 
computer scientists applauding the effort.

But Mr. Green said the company’s move did not seem to take 
into account the views of the privacy and child safety 
communities. “If I could have designed a rollout that was 
intended to fail, it would have looked like this one,” he said.

What matters, experts said, is what Apple will do now that it has 
hit pause. Will it cancel the initiative entirely, simply roll out nearly 
identical features after a delay or find a middle ground?

“We look forward to hearing more about how Apple intends to 
change or improve its planned capabilities to tackle these 
problems without undermining end-to-end encryption, privacy 
and free expression,” Samir Jain, the policy director for the 
Center for Democracy and Technology, an advocacy group, said 
in a statement.

Joe Mullin, a policy analyst with the Electronic Frontier 
Foundation, a digital rights group, said the foundation had a 
petition with more than 25,000 signatures asking Apple not to 
introduce the feature. He said that it was “great that they’re 
taking a moment to think things over,” but that he and other 
privacy coalitions would continue to plead with Apple to abandon 
its plan altogether.
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SOME SPEAKER ROSTER DETAILS 
January 11 - Dan Wissink. Owner of Dan's Tutorials.

February 9 - Terry Wilson. Creator of TightJacket 
customized covers for iPhone and iPad.

March 13 - Michael Blank. Webmaster of the Princeton 
Macintosh Users Group.
April 10- Gary Rosenzweig. Creator of videos for MacMost
May 8 - Dave Hamilton. Started The Mac Observer and Mac 
Geek Gab podcast.
June 13 - Rob Golding. Past President of Princeton 
Macintosh Users Group
September 11 - Aric Pedersen. PMUG’s President and 30-
year Mac user. 

October 9 - Joe Kissel. Publisher of Take Control Books.
November 13 - Bob "Dr. Mac" LeVitus. Prolific speaker and 
author of more than 80 books.
December 11 - Keith Johnson. Web developer.
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Youssef Mohamed posted the following article to medium.com on 
September 25, 2021. cutt.ly/UEmK1Ma. He is a medical student 
interested in writing in general and sharing what he finds with 
others. 

Apple’s Massive 2021 October Event 
The event with all the actual big upgrades 

By Youssef Mohamed 

Introduction 
Apple’s September event was just announced, and it was a good 
one with upgrades to many of their products which are the Apple 
Watch, iPad, iPad mini, and, of course, the new iPhones, but 
what about the other half of Apple’s products such as the Mac, 
MacBook, Airpods, and bigger tablets.

Well, these get their upgrades next month as a part of Apple’s 
other big event that occurs in October specifically to announce 
the upgrades for the bigger more expensive devices, and here is 
what we know till now about next month’s upcoming event.


What will be added to Apple’s lineup 
New MacBook Pros 

Mark Gurman, a trusted journalist, recently reported that the M1X 
MacBook Pros would be coming out within the next few weeks, 
pointing out to an October event.

The new MacBook Pros will probably 
be the biggest announcement and 
probably the one that most people 
have been waiting for with a big 
improvement of the MacBook Pro 16-
inch, the introduction of the 14-inch 
Pro, and of course, the long-awaited 
announcement of the new M1X chip.

M1X: The M1X is Apple’s latest addition to their M-series of 
chips. It is a modified version of the M1 that will be made more 
powerful to be suited for their higher-end products such as the 
new line of MacBook Pros.

The M1 currently has 8 CPU cores with 4 high-performance ones 
and 4 energy-efficient cores, while the more expensive M1X will 
come with 10 CPU cores with an impressive 8 high-performance 
and 2 energy-efficient cores making it a beast suited for much 
heavier tasks.

The current M1 comes with either 7 or 8 GPU cores and provides 
solid performance in terms of graphics, but the higher end chip 
will come with either 16 or 32 GPU cores, maybe the 16 cores for 
the 14-inch and the 32 cores for the 16-inch, but nothing is for 
sure till now.

The 14-inch Pro: Personally, I think this is the best one of their 
devices, and the device I hope to buy. The new Pro will come 
with an upgrade to the size of the screen and a move from the 
previous 13.3 inches of the current model to a new larger 14-inch 
screen. The laptop will also feature of course the performance 
boost due to the addition of the new M1X and will also witness 
the return of many beloved ports such as an HDMI port, an SD 
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card reader, and most importantly the beloved MagSafe charging 
port.

Many rumors state plans to change the design of the laptop to a 
“flat edge design” similar to that of the current iPhone, and it will 
be great if that happens. The screen may also be changed to 
their new MINI-LED technology for a much better screen, and a 
few rumors also say that the new laptop might be the first to 
feature Apple’s 120 Hertz “ProMotion” display, but this might not 
happen with this year’s upgrade.


A possible render for the new design. 
The 16-inch Pro: The biggest and most expensive laptop in 
Apple’s lineup will also get an upgrade this time, as it will get an 
improved MINI-LED display according to some rumors with the 
possibility of the addition of a 120 Hertz display.

The 16-inch will also come with more ports as the same ports 
that have been added to the 14-inch will be added to it as well 
making it as practical as ever. It will of course come with the 
M1X, probably the most powerful version of it with more cores 
than the 14-inch’s version, which is probably the biggest upgrade 
and the thing to look forward to as it will make the biggest 
change to their high-end laptops making this laptop their most 
powerful ever. 

The best Mac Mini ever 

The new Mini will get an upgrade to its design becoming even 
thinner and will probably get a glass top and also will probably 
remove the circular pad on the bottom that has been there for 
years replacing it with two simple rubber horizontal strips to hold 
the new Mini in place instead.

The new Mini will also surprisingly get the new M1X chip even 
though it was destined for the higher end products which will 
make it so much more powerful than any previous Mini model 
and capable of handling all tasks. For additional productivity to a 
device made for users with productivity in mind, Apple will also 
add 2 additional Thunderbolt 4 ports to make them 4.

AirPods 3 

The new Potential design. 
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The new AirPods 3 will finally be announced at this event, and 
they will be getting a redesign by getting a shorter stem and a 
more compact design instead of the longer design of the Airpods 
2.

They will also be the first of the non-pro Airpods to finally get 
active noise cancellation meaning a massive boost to the overall 
experience of using them especially outdoors and driving so 
many customers to buy them. They will also get improved 
battery, waterproofing up to 1m, and even might get an upgrade 
to the audio control system by adding a pressure sensor to the 
stem of the AirPods themselves.


Devices that won’t make it 
Apple has been working so hard to change and upgrade all of 
their devices over the past few months, and they still have so 
many devices in the work, but sadly, not all of them will make it 
to this event as some of them are not ready and will have to wait.

The 24-inch iMac has been recently announced as the successor 
to the old 21.5-inch model, while the current 27-inch iMac is still 
waiting for its turn with a rumored upgrade to a 32-inch iMac 
next year. The new and improved M2 MacBook Air and even the 
new AirPods Pro 2 will also have to wait until the beginning of 
2022 for their upgrades as well.


The potential design for next year. 

When will it be 
Initially, there were reports of 2 separate September events with 
one happening on the 28th of September, but this was not 
destined to happen. The event will probably take place in Mid to 
late October, and according to previous years, it will probably be 
the 19th or 26th of October according to many sources.


Conclusions and personal thoughts 
Out of the two events taking place this fall, personally, I think this 
one is more exciting and has a lot more potential as it has the 
bigger upgrades and the more expensive, powerful, and exciting 
devices with the more powerful computers and laptops.

The M1X in itself is very exciting enough to headline an event, as 
I am very excited to know how Apple plans to handle the 
upgrades to their chips and the future of their processors in 
general, and which direction they will take with the next big step 
in their big chips project.

How much power can they actually cram into their new chip, and 
how they are going to differentiate the M1X chip inside each of 
the devices to be well suited to the needs of the different devices 
without ruining the balance. All this will be answered in that event 
making it an event worth looking forward to.

References
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Kim Kee posted the following article to pcmag.com in 
September, 2021. cutt.ly/kWCVbgU  . © Ziff Davis, LLC. She 
covers security and streaming services for PCMag. She has 
previously written for CNN, Mashable, the New York Times, and 
TechRadar. 

Get Your Life Back From a Cyberstalker 
By Kim Key 

I write about cultivating a private digital life a lot in these 
newsletters because it seems everyone wants a piece of your 
existence. It could be advertising companies using cookies to 
track your browsing habits, or worse, an ex-partner checking 
your text messages and call history via stalkerware. Those 
situations are bad, but this week, a reader email reminded me 
that total surveillance is the ultimate nightmare.


A reader contacted Neil J. Rubenking, Lead Security Analyst here 
at PCMag, and shared a harrowing story about a hacker who 
took over their relative’s digital life. The attacker did it all: read 
their email, changed their passwords, and altered settings to 

remove operating system security features. The victim felt 
helpless to stop them. Rubenking deduced that the attacker 
gained control of the system via a remote access Trojan (RAT), a 
type of malware.


What can you do to combat a RAT infestation? First, you need to 
get a new computer, smartphone, phone number, and email 
address. The scorched-earth policy is the best way to deal with a 
digital life takeover because it doesn't give the hacker any more 
chances to infect your new accounts via your old devices. Use a 
strong password on your new computer account, sign up for an 
encrypted email service, enable multifactor authentication on all 
of your accounts, and install a password manager to keep track 
of all of your new, complex passwords. Of course, you'll need a 
clean install of a security suite as well.


Recovering from a total account takeover can be expensive and 
annoying, but don’t waste any time in reclaiming your life after an 
identity theft catastrophe. Make privacy-first decisions and stick 
with them moving forward.


 

30

https://cutt.ly/kWCVbgU
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhg-e4xll8j9/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhh-e4xll8j0/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhi-e4xll8j1/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhj-e4xll8j2/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhk-e4xll8j3/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhl-e4xll8j4/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhm-e4xll8j5/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyhn-e4xll8j6/
http://click.enews.pcmag.com/click/g6xi-2fz340-gigyho-e4xll8j7/


                 VOLUME 32, NUMBER 10                  MAIN LINE MACINTOSH USERS GROUP             OCTOBER 2021 

The following article was posted to osxdaily.com on September 
9, 2021. cutt.ly/UWVjJp3. © OSX Daily. Try the site. Lots of tips 
and good info. 

How To Add Captions to Photos on 
iPhone & iPad 

Adding captions to photos can help you to add context or a note 
to a picture or video, and this is now easily done on iPhone and 
iPad.

Captions are a useful feature for cataloging images and adding 
notes about a photo too, for example maybe you took a photo of 
people and you wanted to add a caption with each of their 
names, or perhaps you took a photo or video of an event and 
you want to add a caption to specify what it was and help add 
some context to the image, or for future reference. Captions 
could also be helpful when someone else goes through some of 
the photos on your iPhone and they want the context. Another 
benefit to captions? They can be searched by keyword. So 
whatever the use case, adding captions to photos is easy on 
iPhone and iPad.


To be clear, adding captions this way is entirely different from 
adding text to photos, which literally overlays text atop an image.

Let’s take a quick look at how you can add captions to your 
photos ,right on an iPhone or iPad.

The option to add captions is neatly hidden in the Photos app, so 
you may not find it right away. Make sure your device is running 
the latest version of iOS/iPadOS and simply follow the steps 
below to get started.

1. Launch the stock “Photos” app on your iPhone and iPad.

2. Open the photo you want to add a caption to and tap on it. 

Now, swipe up on the photo.

3. Now, you’ll find the new “Add a caption” option at the 

bottom, just above the row of photos. Tap on it to get 
started.


4. Type in the description and tap on “Done” located at the 
top-right corner of the screen.


That’s all there is to using captions in the stock Photos app on 
your iPhone and iPad, pretty simple, right?

The captions you add to images in the Photos app will be synced 
across all your iPhones, iPads, and Macs, provided you have 
iCloud Photos turned on. To check if you have this enabled, just 
go to Settings -> Apple ID -> iCloud -> Photos and you’ll find the 
toggle for enabling/disabling iCloud Photos.

Photos with captions are a lot easier to find in the stock Photos 
app too. That’s right, you can use the search option in the app to 
find a specific photo just by typing the caption you added. You 
don’t even have to type the entire caption if it’s a long one, as the 
Photos app just looks for keywords.

If there’s a character limit for captions it is fairly long, as we tried 
adding some pretty long descriptive captions and it worked just 
fine. So, don’t worry about keeping them as short as you can, 
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but you probably don’t want to write a dissertation as a caption 
either.

We hope you enjoyed adding captions to some of the favorite 
photos on your iPhone and iPad. Is this a feature you’ll be using 
on a regular basis? What other iOS 14 features peaked your 
interest so far? Do share your valuable thoughts and opinions in 
the comments section down below.


The following article was posted to osxdaily.com on August 15, 
2021. cutt.ly/5EaSRiI. © OSX Daily. Try the site.


How to Enable & Use Subtitles & Closed 
Captions on Mac 
Do you want to use subtitles or closed captioning on a Mac? 
Whether you watch a lot of foreign-language movies, TV shows, 
and other video content, or you simply want to use closed 
captions for accessibility reasons, you can easily enable these on 
the Mac.

Many people take advantage of subtitles while watching videos 
on their devices, whether due to hearing impairment or language 
barriers, or preferences.


How to Enable Subtitles & Closed Captions on Mac 
If you have a hearing impairment, you can take advantage of 
Subtitles for the Deaf or Hard-of-Hearing (SDH) that’s buried in 
the accessibility settings in macOS. Simply follow the steps 
below to get started.

1. Head over to “System Preferences” on 

your Mac from the Dock.

2. This will open a new window on your 

screen. Click on “Accessibility” to 
proceed further.


3. Here, you’ll be shown a list of all the 
accessibility settings that are available 
in macOS. Scroll down and click on 
“Captions” as shown in the screenshot 
across.


4. Now, you’ll be able to choose any of the four available 
subtitle styles. Make sure you’ve checked the box for 
“Prefer closed captions and SDH” to start using it across all 
the apps installed on your Mac.
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5. Now, if you open an app like Apple TV+ on your Mac and try 
to watch content, you’ll find the subtitle icon in the playback 
menu as shown below.


Graphic omitted - unreadable.

That’s pretty much all there is to it. Now you’ve learned how to 
enable and use subtitles & closed captions on your macOS 
machine.

From now on, whenever you’re watching video content on your 
Mac, subtitles or closed captions will be displayed on your 
screen whenever they’re available. Also, look out for the subtitle 
icon in the playback menu if they don’t show up automatically.

When this accessibility feature is enabled, you’ll need to choose 
the option that says “SDH” from the list of available subtitles. 
This is due to the fact that subtitles for deaf or hard-of-hearing 
slightly differ from regular subtitles.

Do you use other Apple devices like the iPhone or iPad? If so, 
you might be interested in learning how you can enable and use 
subtitles & closed captions on your iOS devices too. In addition 
to this, you can also change the subtitle font size on iPhone, 
iPad, and Apple TV to make it larger.




The following article was posted to osxdaily.com on August 21, 
2021. cutt.ly/6EaDJ1P. © OSX Daily. Try the site. Lots of tips and 
good info. 

How to Change Subtitle Font Size on Mac 
Are you not happy with the text size of your subtitles while 
watching movies and TV shows on your Mac? Don’t worry. 
Regardless of what app you’re using to watch video content, you 

can change your subtitle font size within a matter of seconds in 
macOS.

Although most people use the default setting for subtitles, some 
people prefer to have larger text sizes so that they’re not 
straining their eyes to read subtitles while watching a movie or 
binging a TV show on their Mac, whether through Apple TV+ or 
Netflix or whatever else you’re using.


How to Change Subtitle Font Size on Mac 
Changing the text size for subtitles is a pretty simple and 
straightforward procedure on macOS devices. This applies to 
any app that displays subtitles during video playback on your 
Mac. Just follow the steps below to get started.

1. Head over to “System Preferences” on your Mac from the 
Dock.

2. This will open a new window on your screen. Click on 
“Accessibility” to proceed to the next step.

3. Here, you’ll be shown a list of all the accessibility settings that 
are available in macOS. Scroll down and click on “Captions” as 
shown in the screenshot below.
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4. Now, you’ll be able to see all the four existing subtitle styles. 
To change the font size, you’ll need to create a new custom 
subtitle. Click on the “+” icon as shown below to get started.


5. In this menu, you’ll find the option to change the text size. 
Click on “Text Size” and use the dropdown menu to select your 
preferred font size. Make sure “Allow video to override” is 
unchecked and then click on “OK”.


There you go. Now you know how easy it is to change the text 
size for subtitles on your Mac.

In the same menu, you can also completely customize how the 
subtitles look. For example, you can change the background 
color, opacity, and even use a different color or font for the 
subtitle text. That being said, the ability to customize your 
subtitles is considered as an accessibility feature in macOS. 
These settings greatly help people with poor eyesight skim 
through subtitles without much strain, as they’re watching a 
video.
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That being said, if you’re looking to take advantage of these 
customized subtitle styles, you need to make sure that subtitles 
& closed captions are enabled on your macOS device.. If you use 
subtitles because you have trouble hearing, you need to choose 
“SDH” from the list of available subtitles. SDH stands for 
subtitles for deaf and hard of hearing, and they differ from regular 
subtitles.

Do you use other Apple devices like the iPhone or iPad? If so, 
you might be interested in learning how you can  change the 
subtitle font size on iPhone, iPad, and Apple TVto make it larger. 
Just like on Mac, you’ll need to make sure that you’ve enabled 
subtitles and closed captions on your iOS device as well.

We hope you were able to change the text size of your subtitles 
on your Mac without any issues. What font size did you choose? 
Did you customize how your subtitles look in any other way? Do 
share your thoughts and experience in the comments section 
down below


Dan Wassink in September, 2021 posted the following article to 
danstutorials.com, a member-only site available at a very 
reasonable rate cutt.ly/aWVHuqw.. © Dan’s Tutorials. Dan 
Wassink is the owner, trainer, and most everything else for Dan's 
Tutorials. More than 1,000 tutorials. 

Wireless Charging Is Wildly Inefficient 

Back in 2017, Apple added support for Qi wireless charging to 
the iPhone 8 and iPhone X. Then with the iPhone 12 lineup, they 
introduced their own MagSafe wireless charging technology. 
There’s no denying the convenience of wireless charging, keep in 
mind that it’s extremely inefficient compared to wired charging. In 
most cases, that may not matter much because you may be 
Charging overnight from a wall-connected charger. Charging 
speed suffers with wireless charging. If you need a quick charge, 
plug your iPhone in. Also, across billions of phones, it’s more 
problematic. One estimate suggests that wireless charging 
requires nearly 50% more power than cable. And if you’re 
charging from a wireless battery pack, wasting that juice means 
less of a top-up before exhausting the battery pack. In short, to 
charge your iPhone quickly and efficiently, whether from a wall-
connected charger or a battery pack, stick with the traditional 
Lightning cable. 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Jeff Butts posted the following article to MacObserver.com on 
September 17, 2021. tinyurl.com/ybnvdwbe. © The Mac 
Observer Inc. He’s been working on computers since before he 
ever thought about teaching.  

Apple Moves More Devices from 
Lightning to USB-C 
By Jeff Butts 

For obvious reasons, many people wish that Apple would use the 
same power connector on the iPhone that other smart phones 
use. Granted, none of us wanted to see microUSB on the iPhone. 
However, USB-C would be a great thing. Evidence is mounting 
that Apple may soon do just that. Looking at changes to other 
Apple devices, it certainly seems that the Lightning adapter’s 
days may be limited as two more products make the move from 
Lightning to USB-C.


One More iPad Model Moves from Lightning to 
USB-C 
The Lightning connector has been around since the iPhone 5 in 
2012. Since then, however, Apple has transitioned several of its 
devices from Lightning to USB-C. These include the iPad Pro, 
iPad Air, and now the iPad mini. Apple was already using USB-C 
on its MacBook Pro and MacBook Air, but those were never 
Lightning devices to begin with.


The base model of the iPad remains on Lightning. Of course, 
there are also several Apple accessories using Lightning 
chargers. The Magic Keyboard, Magic Trackpad 2, and Magic 
Mouse 2 all charge via the Lightning adapter. So do Apple’s 
AirPods and AirPods Pro.

With Cupertino’s announcement of the new iPad mini, however, 
we saw one more device switch from Lightning to USB-C. The 
latest iPad mini joins the iPad Pro and iPad Air in adopting USB-
C for charging and connecting wired accessories.


Another Nail In the Lightning Adapter’s Coffin? 
The Apple Watch Series 7, announced the same day as the 
iPhone 13, uses a new fast charging USB-C cable. Cupertino 
claims that it will charge up to 33% faster than the Series 6.


At the same time, Apple is transitioning some other models of the 
Watch to the USB-C charger. The Apple Watch SE now ships 
with the USB-C Apple Watch charger rather than the USB-A 
variety. Interestingly enough, Apple Watch Series 6 hasn’t 
changed over … yet.

I doubt that many would mourn the loss of the lightning adapter. 
Yes, it would eventually mean people needing to get new cables 
and adapters. However, consumers switching from other 
smartphones to the iPhone probably already have more USB-C 
cables than they know what to do with. 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Apple posted the following article to apple.com.  cutt.ly/6EvJXu9. 
March 21, 2021 © Apple Inc. 

Set up iCloud Keychain 
With iCloud Keychain, you can keep your passwords and other 
secure information updated across your devices. 

iCloud Keychain remembers things, so that you don't have to. It 
auto-fills your information—like your Safari usernames and 
passwords, credit cards, and Wi-Fi passwords on any device that 
you approve. Have more questions about iCloud Keychain?


How to turn on iCloud Keychain 
When you update your device to the  latest iOS or iPadOS, the 
setup assistant asks you to set up iCloud Keychain.  Learn 
about availability by country or region.


Turn on iCloud Keychain on your iPhone, iPad, or 
iPod touch 
1. Tap Settings, tap [your name], then choose iCloud.

2. Tap Keychain.*

3. Slide to turn on iCloud Keychain. You might be asked for 

your passcode or Apple ID password.  

Turn on iCloud Keychain on your Mac 
1. Choose Apple menu  > System Preferences. 

2. Click Apple ID, then click  iCloud  in the sidebar.  In macOS 

Mojave or earlier, click iCloud.

3. Select Keychain.*
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4. If you choose to "Approve Later" when signing into your 
Apple ID, you need to approve with an old passcode or 
from another device when prompted. If you're unable to 
approve, reset your  end-to-end encrypted data  when 
prompted.


*On your iPhone, iPad, or iPod touch with iOS 13 or later, or on 
your Mac with macOS Catalina or later, two-factor authentication 
is required to turn on iCloud Keychain. If you haven't set it up yet, 
you're prompted to update to two-factor authentication.


If you can't turn on iCloud Keychain 
If you can't turn on iCloud Keychain after following these steps, 
make sure you  meet the  minimum system requirements for 
iCloud Keychain and that you're using two-factor authentication. 

If you're not using two-factor authentication, you might be 
prompted to create an iCloud Security Code—six digits, complex 
alphanumerics, or randomly generated—to authorize additional 
devices and verify your identity. If you forgot your code,  you 
might be able to reset it.


Frequently asked questions 
Get answers to some of the most common questions about 
iCloud Keychain.

What information does iCloud Keychain store? 
iCloud Keychain stores credit card numbers and expiration dates
—without storing or autofilling the security code—and 
passwords and usernames, Wi-Fi passwords, Internet accounts, 
and more. Developers can also update their apps to use 
keychain, if the app is on a device that uses iOS 7.0.3 or later, or 
OS X Mavericks 10.9 and later.  If you don't see items stored in 
iCloud Keychain, learn what to do. 

How does iCloud Keychain protect my information? 

iCloud protects your information with end-to-end encryption, 
which provides the highest level of data security. Your data is 
protected with a key that's made from information unique to your 
device, and combined with your device passcode, which only 
you know. No one else can access or read this data, either in 
transit or storage. Learn more.

What happens when I turn off iCloud Keychain on a device? 
When you turn off iCloud Keychain for a device, you're asked to 
keep or delete the passwords and credit card information that 
you saved. If you choose to keep the information, it isn't deleted 
or updated when you make changes on other devices. If you 
don't choose to keep the information on at least one device, your 
Keychain data will be deleted from your device and the iCloud 
servers. 

Can Apple recover my iCloud Security Code? 
No. If you enter your iCloud Security Code incorrectly too many 
times, you can't use that iCloud Keychain. You can contact Apple 
Support  to  verify your identity and try again. After several 
incorrect attempts, your keychain is removed from Apple's 
servers, and you need to set it up again.

How do I find my saved passwords? 
iCloud Keychain stores your saved passwords so that you can 
view or change them at any time. Learn how to find your saved 
passwords on your iPhone, iPad, or iPod touch. You can also 
find your saved passwords on your Mac. 
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Apple posted the following article to apple.com.  cutt.ly/
tEvJHNN. March 21, 2021 © Apple Inc. 

Manage Passwords Using Keychains on 
Mac 
macOS uses keychains to help you keep track of and protect the 
passwords, account numbers, and other confidential information 
you use every day on your Mac computers and iOS and iPadOS 
devices.

You can use the Keychain Access app on your Mac to view and 
manage your keychains. When you use iCloud Keychain, you can 
keep your passwords and other secure information updated 
across your devices.


What is a keychain? 
A keychain is an encrypted container that securely stores your 
account names and passwords for your Mac, apps, servers, and 
websites, and confidential information, such as credit card 
numbers or bank account PIN numbers.

When you access a website, email account, network server, or 
other password-protected item, you can choose to save the 
password in your keychain so you don’t have to remember or 
enter the password each time.


Each user on a Mac has a login keychain. The password for your 
login keychain matches the password you use to log in to your 
Mac. If an administrator on your Mac resets your login password, 
you need to reset your login keychain password.


Keychain Access 
You use the Keychain Access app on your Mac to view and 
manage your login and other keychains, and also the items 
securely stored in the keychains—for example, keys, certificates, 
passwords, account information, and notes. If you forget a 
password, you can find it in Keychain Access. Learn more about 
Keychain Access.
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iCloud Keychain 
If you use iCloud, you can have iCloud Keychain securely store 
the website login information and credit card information you use 
with AutoFill in Safari, and your Wi-Fi network information. iCloud 
Keychain automatically keeps that information up to date across 
all your Mac computers and iOS and iPadOS devices. iCloud 
Keychain also stores login information for the accounts you use 
in Mail, Contacts, Calendar, and Messages so it’s available on all 
your devices. Learn more about iCloud Keychain.




Tip: When you use passwords and credit cards online, you can 
let Safari store them in your keychain and automatically fill them 
in for you. If you also use iCloud Keychain on your Mac and iOS 
and iPadOS devices, Safari can fill in the stored information on 
any of your devices. See AutoFill credit cards, contacts, and 
passwords.

See also

Learn how passwords are used on Mac

If you forget your login password on Mac

If you need to update your keychain password

Apple Support article: Set up iCloud Keychain
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The following article was posted to osxdaily.com on September 
19, 2021. cutt.ly/BEcFqqz. © OSX Daily. Try the site. Lots of tips 
and good info. 

How to Enable On-Device Translate 
Mode on iPhone 

Have you tried out the Translate app on your iPhone to make 
language translations and communicate with someone who 
speaks a different language? If so, you may be interested in 
using its on-device mode to make sure the translations are not 
made on Apple’s servers.

For those who aren’t aware, Apple has added an all-new 
Translate app to make real-time language translations easy and 
convenient on the iPhone. It competes against the offerings 
made by Google, Microsoft, and other third-party developers. Of 
course, just like any other translation app or service, it relies on 
internet connectivity to work, but that’s only optional here. If you 
don’t want to connect to Apple’s servers, you can use the on-
device mode to make translations offline, provided you have the 
languages downloaded.


How to Enable On-Device Mode for Translate on 
iPhone 
Turning on On-Device mode or always offline mode for 
translations is a pretty simple and straightforward procedure. 
Just follow the steps below to get started.

1.  Go to “Settings” from the home screen on your iPhone.

2.  Here, scroll down and find “Translate” among the list of apps. 
Tap on it to proceed.


3.  Use the toggle to enable On-device mode, as shown below.


41

https://cutt.ly/BEcFqqz


                 VOLUME 32, NUMBER 10                  MAIN LINE MACINTOSH USERS GROUP             OCTOBER 2021 

4.  You will now get a pop-up on the screen informing you that 
you’ll need to download languages to use this mode. Choose 
“Open App” to get started.


5.  Once you’re in the Translate app, tap on either of the 
languages here to enter the language selection menu.


6.  Here, scroll down to view all the available offline languages. 
Tap on the download icon next to a language to save the 
language for offline use.


Once On-device mode is enabled for the Translate app, you 
won’t be able to make any translations unless you have 
downloaded both of the selected languages.

That being said, you don’t need to enable this mode for simply 
using offline translations. This feature is strictly for the privacy 
buffs who don’t want to use Apple’s servers for processing 
translation requests.

It’s worth pointing out that translations that are made on the 
device are not as accurate as the ones that are processed on 
Apple’s servers. So, this may not be the best option if you’re 
looking for the utmost accuracy in your translation results. 
Rather, it’s just one of the ways Apple keeps its users at the 
forefront of privacy.

Since on-device mode doesn’t require a connection to any 
servers, you’ll be able to keep making translations using the app 
even if you’re in the middle of a flight where there’s no Wi-Fi or if 
you’re in a remote location with no cellular network.
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